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1. INTRODUCTION 93 

 94 

 95 

1.1. GENERAL INFORMATION ABOUT ENTSOG TRANSPARENCY PLATFORM 96 

 97 

Regulation (EC) № 715/2009 and its amendments require ENTSOG to provide a Union-wide 98 

platform where all Transmission System Operators for gas shall make their relevant data publicly 99 

available. The first common platform has been set up by the TSOs on a voluntary basis in 2008 and then 100 

improved in 2013 in order to comply with changed Transparency regulation requirements (Chapter 3 of 101 

Annex №1 to Regulation (EC) № 715/2009 and its amendments). 102 

 103 

On 1 October 2014, ENTSOG launched a new Transparency Platform. 104 

 105 

By providing free of charge vast information related to gas transmission in an organised and structured 106 

way, the platform is a further contribution by TSOs for gas to enhance transparency in the European 107 

energy market. 108 

 109 

The Transparency Platform provides technical and commercial data on gas transmission systems, which 110 

include interconnection points and connections with storages, LNG facilities, distribution networks, final 111 

consumers and production facilities. 112 

 113 

The platform is available on web address: https://transparency.entsog.eu  where the interested parties 114 

are able to access valuable information uploaded by all TSOs. 115 

 116 

 117 

1.2. AIM OF THIS DOCUMENT 118 

 119 

The purpose of this document is to give an overview of ENTSOG Transparency Platform (hereinafter 120 

referred to as “TP” or as the “Platform”) as well as some practical tips and information on how to use its 121 

functionalities. 122 

 123 

 124 

1.3. SYSTEM REQUIREMENTS FOR USING ENTSOG TRANSPARENCY PLATFORM 125 

 126 

ENTSOG recommends that you visit its Transparency Platform using a modern web or mobile browser 127 

(Internet Explorer 10 or later, latest versions of Chrome or Mozilla Firefox). 128 

 129 

 130 

 131 

 132 

 133 

 134 

 135 

 136 

https://transparency.entsog.eu/


2. GENERAL STRUCTURE OF ENTSOG TRANSPARENCY PLATFORM  137 

 138 

 139 

The main structure elements of ENTSOG Transparency Platform are: 140 

 141 

> MENU BAR 142 

> SEARCH BAR 143 

> ROLLING BANNER 144 

> MAP 145 

> DATA PART 146 

 147 

In the next chapters of this manual you will find a detailed description of each structure element and its 148 

parts. 149 

 150 

 151 

 152 

 153 

 154 

 155 

 156 

 157 

 158 

 159 

 160 

 161 

 162 

 163 

 164 

 165 

 166 

 167 

 168 

 169 

 170 

 171 

 172 

 173 

 174 

 175 

 176 

 177 

 178 

 179 

 180 



3. MENU BAR 181 

 182 

 183 

The menu bar provides direct access to the main TP menus. 184 

 185 

 186 
 187 

 188 

3.1. MENU POINTS 189 

 190 

 191 
 192 

Through the Points menu you can access: 193 

 TP map - showing all relevant points;  194 

 Tool for advanced point search; 195 

 Data part of the Platform dedicated for Point information – providing graphical and numerical 196 

data about all indicators for the selected point(s). 197 

 198 

 199 

3.2. MENU ZONES 200 

 201 

 202 
 203 

Through Zones menu you can access: 204 

 TP map - showing all Balancing Zones; 205 

 Tool for advanced zone search; 206 

 Data part of the Platform dedicated for Zone information - providing graphical and numerical data 207 

for the selected zone(s). 208 

 209 

 210 



3.3. MENU OPERATORS 211 

 212 

 213 
 214 

The Operators menu leads the TP user directly to a sub-page listing all TSOs that are participating and 215 

publishing data on the TP. 216 

 217 

 218 
 219 

 220 

A separate tab is dedicated for each TSO: 221 

 222 

 223 
 224 

By clicking on an individual TSO tab, a pop-up opens with information and access to: 225 

 TSO’s web site transparency section; 226 

 Links to specific sections on TSO’s web site with information on applied tariff, tariff calculator, 227 

maintenance information, capacity data, access conditions and etc.; 228 

 General information and contact details for the TSO; 229 



 List of TSO’s Points; 230 

 List of TSO’s Balancing Zones; 231 

 Balancing information for the TSO; 232 

 Capacity information for the TSO; 233 

 Tariff information for the TSO. 234 

 235 

 236 
 237 

 238 

3.4. MENU CALENDAR 239 

 240 

 241 
 242 

The Calendar menu leads the TP user to a sub-page providing information about the planned and non-243 

planned interruptions and Urgent Market Messages, published by all or selected TSO(s) for a certain 244 

configurable by the user period (month, week or day).  245 

 246 

 247 
 248 

The colour of the information on the Calendar depends on the type of information presented. The colour 249 

code for the different type of announced interruptions is:  250 

 251 

 252 

 253 

 254 



Colour code Type of information 

Red Urgent Market Messages 

Red Unplanned interruption of Firm Services 

Orange Planned Interruptions of Firm Services 

Blue Planned Interruptions of Interruptible Capacity 

Grey Actual Interruptions of Interruptible Capacity 

 255 

 256 

 257 
 258 

 259 

3.5. MENU SUBSCRIBE 260 

 261 

 262 
 263 

The Subscribe section allows the TP users to sign up for RSS feeds to receive announcements about new 264 

publications in the following rubrics: 265 

 Urgent Market Messages; 266 

 Planned Interruptions of Firm Services; 267 

 Unplanned Interruptions of Firm Services; 268 

 Planned Interruptions of Interruptible Capacity; 269 

 Actual Interruptions of Interruptible Capacity. 270 

 271 



 272 
 273 

 274 
 275 

ENTSOG provides to the TP users an Automated Download Tool. 276 

A user guide with details on how to configure ENTSOG TP REST APIs and to set up direct download of 277 

information published on the Platform, bypassing any web layer, is accessible through the SUBSCRIBE -> 278 

API MENU. 279 

 280 

 281 

3.6. MENU HELP 282 

 283 

 284 
 285 

The Help menu opens a sub-page with Frequently Asked Questions, tips and user manual for the ENTSOG 286 

Transparency Platform. 287 

 288 



 289 
 290 

 291 

3.7. MENU LOGIN 292 

 293 

 294 
 295 

The Login menu provides access for the Registered TP users to some additional functionalities of the 296 

Platform: 297 

 To create groups of Favourite objects – valid for all Registered TP users; 298 

 To publish REMIT messages (UMMs) – valid only for TSO Registered TP users upgraded to REMIT 299 

users. 300 

 301 

After login, the Registered TP user can verify the user details and change its login password: 302 

 303 

 304 
 305 

 306 

 307 

 308 

 309 

 310 



3.8. FAVOURITES MENU 311 

 312 

The Favourites menu is available only for Registered and logged-in TP users. 313 

 314 

 315 
 316 

 317 
 318 

When logged-in, the TP user has access to all TP features and functionalities available to other users. In 319 

addition, the logged-in user can create one or many groups of “favourite” objects. The user-defined 320 

groups provide fast access (shortcuts) to the data related to “favourite” objects.  321 

 322 

 323 
 324 

A new group of favourite objects can be created through the button “Create new group”: 325 

 326 

 327 
 328 

To add a point/object as “favourite” in one of the user-defined groups, type the name of the 329 

point/object in the Search bar. During the typing process a drop-down menu with a list of the objects 330 

which match the typed name appears below the Search bar. 331 

 332 

 333 

 334 

 335 



Select the preferred point/object by clicking the Star  symbol next to the name of the object: 336 

 337 

 338 
 339 

Test example of user defined group of favourite points: 340 

 341 

 342 
 343 

 344 

 345 

 346 

 347 

 348 

 349 

 350 



The data for a group or favourite objects can be accessed through the Bar chart  symbol: 351 

 352 

 353 

A user defined group of favourite objects can be deleted using the X-crossing  symbol: 354 

 355 

 356 
 357 

 358 
 359 

Another possibility for a logged-in Registered TP user to make a point or zone a favourite object is to 360 

select it from the Recently Viewed Items (Left Map Sidebar) by clicking on the Start  symbol next to 361 

the name of the object of interest:  362 

 363 

 364 



 365 
 366 

Once you have defined your favourites, you can export related data easily using the Point Export Wizard 367 

(Please refer to the Export Wizard section 7.4.6. for more details). 368 

 369 

 370 
 371 

How to become Registered TP user? 372 

 373 

 374 
In order to become Registered TP user: 375 

1. Select the menu Login; 376 

2. Press on the link Request credentials; 377 

3. Fill in the required information; 378 

4. Accept the Terms and conditions of use; 379 

5. Press the button Register; 380 

6. The login credentials will be sent to the email address pointed during the registration process. 381 

 382 



 383 
 384 

 385 

 386 

 387 

 388 

 389 

 390 

 391 

 392 

 393 

 394 

 395 

 396 

 397 



4. ROLLING BANNER 398 

 399 

 400 

 401 
 402 

The Rolling banner shows dynamically information about the valid for the current period interruptions: 403 

 Urgent Market Messages; 404 

 Planned Interruptions of Firm Services; 405 

 Unplanned Interruptions of Firm Services; 406 

 Planned Interruptions of Interruptible Capacity; 407 

 Actual Interruptions of Interruptible Capacity. 408 

 409 

Only the most recent messages, impacting the TSOs networks currently and/or in the future, are 410 

displayed. 411 

 412 

 413 
 414 

Click on the Rolling banner to display the details of the message currently shown. 415 

 416 

 417 



 418 
 419 

The colour of the Rolling banner changes depending on the type of information presented. The messages 420 

valid for the current period visualised in the Calendar section are displayed consecutively on the Rolling 421 

banner. The colour code of the Rolling banner repeats the colour code of each particular message from 422 

the Calendar area:  423 

 424 

Colour code Type of information 

Red Urgent Market Messages 

Red Unplanned interruption of Firm Services 

Orange Planned Interruptions of Firm Services 

Blue Planned Interruptions of Interruptible Capacity 

Grey Actual Interruptions of Interruptible Capacity 

 425 

 426 

 427 
 428 

 429 

 430 

 431 

 432 

 433 

 434 

 435 

 436 

 437 

 438 

 439 

 440 

 441 

 442 

 443 



5. MAP 444 

 445 

 446 

 447 
 448 

The Transparency Platform Map is accessible from several TP sections: 449 

 From the TP home page; 450 

 From the menu Points; 451 

 From the menu Zones. 452 

 453 

The map displays all the points configured for visualisation by ENTSOG. Please note that it does not 454 

necessarily display all the points accessible through the Search bar.  455 

 456 

 457 
 458 

By default, the map on the TP home-page shows only Transmission points and operational pipelines in 459 

Europe. 460 

 461 



 462 
 463 

To show all relevant points on the map for which the TSOs are publishing data on the TP, click once on 464 

the POINT menu button. 465 

 466 

 467 
 468 

 469 
 470 

To show on the map the Balancing Zones configured on ENTSOG TP, simply click once on the ZONE menu 471 

button. 472 

 473 

 474 



Alternatively, go to ZONES menu and select MAP. 475 

 476 

 477 
 478 

Each of the Balancing Zones is indicated by an orange point  479 

 480 

 481 
 482 

 483 
 484 

If you press and hold the primary mouse button on the screen, you can drag and move the map on the 485 

display to focus on a particular area.  486 

 487 

 488 



5.1. MAP OBJECTS 489 

 490 

The Map can display the following objects: 491 

 Points; 492 

 Balancing Zones; 493 

 Pipelines; 494 

 Locations; 495 

 Gas fields; 496 

 Drilling platforms. 497 

 498 

The visualisation of these objects is configurable through map filtering and display setting options from 499 

the right side bar of the map (Please refer to the explanation in point 5.2. Right Sidebar Menu). 500 

By clicking on particular map point or zone symbol a pop-up window appear. 501 

 502 

Point pop-up: 503 

 504 

 505 
 506 

Zone pop-up: 507 

 508 

 509 



 POINT POPUPS 510 

 511 

When clicking on a point a pop-up window appear. It contains information about the: 512 

 513 

 Point name; 514 

 Point type: 515 

○ Physical; 516 

○ Virtual; 517 

 Type of points based on their function: 518 

○ Cross-border Transmission IP within EU; 519 

○ Cross-border Transmission IP between EU and Non-EU; 520 

○ Storage IP; 521 

○ Cross-Border Storage IP within;  522 

○ LNG Entry IP; 523 

○ Trading point; 524 

○ Transmission point; 525 

○ Final Customers point; 526 

○ Production IP; 527 

○ Distribution IP; 528 

 Point EIC; 529 

 Type of points based on their CAM relevance: 530 

○ CAM-Relevant; 531 

○ Non-CAM-Relevant; 532 

 Connected operators; 533 

 Connected Balancing Zones; 534 

 Point information per direction. 535 

 536 

 537 
 538 



 539 
 540 

The pop-up window of the virtual interconnection points (VIP) provides more details. The VIP pop-up 541 

contains information for the virtual point and for the virtualised physical points. 542 

 543 

 544 
 545 

Each point direction is presented by a tab in the point pop-up window. 546 

The pop-up of a unidirectional point (entry only or exit only) has only one tab, respectively the pop-up of 547 

a bidirectional point has two tabs. 548 

 549 

 550 

 551 

 552 

 553 

 554 

 555 

 556 

 557 

 558 

 559 

 560 



 561 
 562 

 Point pop-up of a unidirectional point: 563 

 564 

 565 
 566 

 567 
 568 

The bidirectional points have two tabs – one for each point direction: 569 

 570 

 571 
 572 

 573 

 574 

 575 

 576 

 577 



You can switch between the tabs simply by changing your selection. 578 

 579 

 580 
 581 

 582 
 583 

When a physical point has been virtualised, the point pop-up shows the name of the virtual point in 584 

which the physical point was included following virtualisation, as well as additional information about 585 

the start date of the virtualisation and details on capacity marketing: 586 

 587 

 588 
 589 

 590 
 591 

You can access the data published by the respective operators for the point either by selecting the Bar  592 



chart  symbol next to the balancing zone name or by clicking on the Access data page button593 

. 594 

 595 

 596 
 597 

 598 
 599 

The Plus sign  provides fast access to information about the physical flow and the technical capacity 600 

of the point for the selected direction during the current gas day. 601 

When clicking on the Plus sign a drop-down menu appears and the sign turns to Minus  602 

 603 

 604 
 605 



 ZONE POPUPS 606 

 607 

When clicking on a zone symbol a pop-up window appears which contains information about the: 608 

 Zone name; 609 

 Zone EIC; 610 

 All entry points of the zone; 611 

 All exit points of the zone; 612 

 Information of the aggregated entries to adjacent zones; 613 

 Information of the aggregated exits to adjacent zones. 614 

 615 

The data is accessible via several tabs: 616 

 Entry points tab – lists all entry points to the zone, as well as the adjacent Balancing Zones and 617 

operators;  618 

 Exit points tab – lists all exit points from the zone, as well as the adjacent Balancing Zones and 619 

operators;  620 

 Aggregate entries tab – lists the adjacent Balancing Zones and operators in the entry direction of 621 

the zone; 622 

 Aggregate exits tab – lists the adjacent Balancing Zones and operators in the exit direction of the 623 

zone. 624 

 625 

 626 
 627 

 628 



 629 
 630 

The navigation details of zone pop-ups repeat the navigation functions described earlier in point 5.1.1 for 631 

point pop-ups.   632 

 633 

 634 
 635 

The Plus sign  at entry/exit points tabs provides fast access to information about the physical flow 636 

and the technical capacity of the zone for a selected direction, during the current gas day. 637 

When clicking on the Plus sign a drop-down menu appears and the sign turns to Minus  . 638 

 639 

 640 



The Plus sign  at the aggregate entries/exits tabs provides fast access to information about the 641 

physical flow for a selected direction, during the current gas day. 642 

 643 

 644 
 645 

 646 

5.2. RIGHT SIDEBAR MENU 647 

 648 

The information displayed on the Map is configurable through the Sidebar menu accessible on the right 649 

side of the screen. 650 

 651 

 652 
 653 

 654 



The Sidebar menu provides access to the following tools: 655 

 Zoom In and Zoom Out tool; 656 

 Full Screen map; 657 

 Display settings of the map; 658 

 Filters of the information on the map; 659 

 Legend of the map symbols and colour codes. 660 

 661 

 ZOOM 662 

 663 

The map can be Zoomed In and Zoomed Out through a sidebar buttons: 664 

 665 

 666 
 667 

5.2.1.1. ZOOM IN 668 

 669 

Using the Zoom In function, the TP user can get a closer view of a chosen area on the map: 670 

 671 

 672 
 673 



 674 
 675 

If the primary button mouse is double-clicked on the map it has a Zoom In effect.  676 

If the mouse is scrolled forward it has a Zoom In effect. 677 

 678 

5.2.1.2. ZOOM OUT 679 

 680 

Through the Zoom Out function the TP user can return to a more general outline of the map: 681 

 682 

 683 
 684 

 685 
 686 

Scrolling the mouse backwards has a Zoom Out effect. 687 

 688 

 689 

 690 

 691 

 692 

 693 

 694 

 695 

 696 

 697 

 698 

 699 

 700 



 FULL SCREEN 701 

 702 

 703 
 704 

The Full Screen button on the Sidebar allows the TP user to expand the view of the map on the whole 705 

screen.  706 

 707 

 708 
 709 

 710 
 711 

If the mouse is double-clicked on the map it has a Zoom In effect. 712 

If you press and hold the primary mouse button on the screen, you can drag and move the map on the 713 

screen.  714 

To return from Full Screen map view to normal TP mode, press the ESC key on the keyboard.  715 



 DISPLAY SETTINGS 716 

 717 

The information shown on the map can be managed through the Display settings menu. 718 

 719 

 720 
 721 

The Display settings menu allows users to show or hide the following categories of details on the map: 722 

 Gas fields; 723 

 Drilling platforms; 724 

 Projected points and pipelines; 725 

 Small pipelines; 726 

 Medium pipelines; 727 

 Large pipelines; 728 

 Country names; 729 

 Location names. 730 

 731 

 732 



 733 
 734 

 735 
 736 

This is an example depicting the relevant points and only the large pipelines with a diameter bigger than 737 

900 mm in Europe: 738 

 739 

 740 
 741 

 742 

 743 

 744 



 FILTERS 745 

 746 

 747 
 748 

The Filters menu allows users to filter the information to be displayed on the map. The user can select 749 

to: 750 

 Show or hide all connection points on the map; 751 

 Show and hide all Balancing Zones on the map; 752 

 Display only Operational points or only Projected points; 753 

 Display only Interconnection points, or only Trading points or only Cross-border points; 754 

 Display only the points within EU, or only the NON-EU points, or the connection points between 755 

EU and NON-EU countries; 756 

 Filter the points shown on the map depending on the type of the infrastructure they are 757 

connected to, i.e. to display only the connection points to Distribution systems; or only the 758 

connection points to Transmission systems,  or only the connection points to Final consumers,  or 759 

only the connection points to Storage facilities, or only the connection points to Transmission 760 

systems,  or only the connection points to Production facilities, or only Trading points or only the 761 

Entry points from LNG Terminals.   762 

 Show information for one selected TSO or for all TSOs; 763 

 Show information for one selected Balancing zone or for all Balancing Zones; 764 

 Show information for one selected country or for all countries; 765 

 Show only CAM-Relevant points or only  NON CAM-Relevant points; 766 

 Show Balancing Zones of selected country. 767 

   768 

 769 



 770 
 771 

 772 

 773 

 774 

 775 

 776 

 777 



 778 
 779 

Example for filtering the points displayed on the map to: 780 

Cross-border transmission points of Germany which are CAM-Relevant, plus the available Balancing 781 

Zones in Germany. 782 

 783 

 784 
 785 

 786 

 LEGEND 787 

 788 

 789 



The Legend shows the meaning of the symbols and colour codes used on the map. 790 

 791 

 792 
 793 

 794 

 795 

 796 

 797 

 798 

 799 

 800 

 801 



5.3. LEFT SIDEBAR - RECENTLY VIEWED ITEMS 802 

 803 

The Left hand sidebar consists of a single button providing direct access to the Recently Viewed Items. 804 

 805 

 806 
 807 

 808 
 809 

As Recently Viewed Items will be shown the objects for which you have recently explored information, 810 

searched through the Search bar or clicked on the map. 811 

 812 

 813 

 814 

 815 

 816 

 817 

 818 

 819 

 820 

 821 

 822 

 823 

 824 

 825 

 826 

 827 

 828 

 829 

 830 

 831 

 832 

 833 



 834 
 835 

By clicking on the Current button , the TP user can get access to the recently explored by 836 

him/her objects (points, zones) on the TP. 837 

 838 

 839 
 840 

The Recently Viewed Items sidebar has two tabs: 841 

 842 

 843 
 844 

The tab Points contains a list of the recently viewed points. 845 

The tab Zones contains a list of the recently viewed zones. 846 



 RECENTLY VIEWED POINTS 847 

 848 

The Points tab displays the last twenty points that you have visited (e.g. clicked on, searched and 849 

explored).  850 

 851 

 852 
 853 

 854 

5.3.1.1. UNFOLDING ADDITIONAL POINT INFORMATION 855 

 856 

Each point can be unfolded. By clicking on a point name, information for connected at that point 857 

Operators, Balancing Zones and available point Directions will be shown.  858 

 859 



 860 
 861 

The level at which the connected Balancing Zones are denoted is named “Arc level”: 862 

 863 

 864 
 865 

The level at which the connected operators and respective point directions are listed is named 866 

“Operators level”: 867 

 868 

 869 



5.3.1.2. DIRECTION INDICATORS 870 

 871 

The available point directions are marked with arrows: 872 

 Exit point direction for the selected operator; 873 

 Entry point direction for the selected operator. 874 

 875 

 876 

5.3.1.3. ACCESS TO DATA PART 877 

 878 

If you click on the Bar chart  symbol at the Arc Level, you can get access to the data published by both 879 

connected operators for the point. 880 

In the example below, you will get direct access to the data published by GASCADE in exit direction and 881 

by OGE for entry direction of the point Lampertheim I. 882 

 883 

 884 
 885 

To hide the data displayed on the data panel you click once again on the Bar chart  symbol at Arc 886 

Level.  887 

In order to hide the information published by GASCADE and to leave on the screen only the graph for the 888 

OGE data, press on the Minus sign  symbol next to GASCADE name at Operators level. 889 

      890 

If you click on a Bar chart  symbol at Operators level, you will display the information published by 891 

the respective operator - in the example below -  the information published by GASCADE in exit direction 892 

for the point Lampertheim I. 893 



 894 
 895 

If you would like to display the information published by the adjacent operator, click on the Bar chart 896 

symbol or on the Plus  sign next to its name. In the example below – click on the Bar chart or Plus sign 897 

symbol next to OGE name at Operator level. 898 

 899 

 900 
 901 

 902 
 903 

Clicking on the Bar chart  symbol in the Recently Viewed Items will always clean up the previously 904 

displayed chart content. For Example, if the chart displayed ten series before, clicking on the Bar chart 905 

symbol will remove these ten series and then show your new selection. 906 

You can add or remove data series selectively, by using the  /  buttons. This will not clean up any 907 

previously displayed content in the chart. 908 

The selection in Recently Viewed Items applies to all the tabs in the Points Data page. 909 



You can remove a point from the list of Recently Viewed Items by clicking on the Cross  symbol next 910 

to its name: 911 

 912 

 913 
 914 

If you are a Registered TP user and you are logged in to your TP user profile, you can add as “favourite” 915 

item a point listed in the Recently Viewed Items by clicking on the Star  symbol: 916 

 917 

 918 
 919 

By clicking on the Balloon  symbol next to the name of the point in the list of Recently Viewed Items 920 

you can get it visualised on the TP map: 921 

 922 

 923 
 924 

 925 

 926 

 927 



To clear the list of the Recently Viewed points, press on the button “Clear all points”: 928 

 929 

 930 
 931 

 932 

 RECENTLY VIEWED ZONES 933 

 934 

The Zones tab displays the recently visited by the TP user Balancing Zones.  935 

 936 

 937 
 938 

 939 

 940 

 941 

 942 

 943 

 944 

 945 

 946 



5.3.2.1. UNFOLDING ADDITIONAL ZONE INFORMATION 947 

 948 

For each zone listed in the Recently Viewed Items additional information can be displayed.  949 

By clicking on a zone name, information about the Operator(s) that belong to the selected Balancing 950 

Zone and the adjacent Balancing Zones is unfolded. The unfolded items present all aggregated entries 951 

and exits to and from the selected Balancing Zone and its adjacent zones. 952 

 953 

 954 

 955 
 956 

 957 

5.3.2.2. DIRECTION INDICATORS 958 

 959 

The flow direction between the adjacent zones is shown by the following direction arrow signs: 960 

 Aggregated exits out of the selected balancing zone and operator; 961 

 Aggregated entries into the selected balancing zone and operator. 962 

 963 

 964 

5.3.2.3. ACCESS TO DATA PART 965 

 966 

By clicking on the Bar chart symbol   or Plus  sign next to the name of selected adjacent Balancing 967 

Zone you can directly access the data published by the respective operator for the flow between two 968 

Balancing Zones. 969 



 970 
 971 

 972 

 973 

You can remove a zone from the list of Recently Viewed Items by clicking on the Cross  symbol next 974 

to its name: 975 

 976 

 977 
 978 

By clicking on the Balloon  symbol next to the name of the zone in the list Recently Viewed Items you 979 

can get it visualised on the TP map: 980 

 981 



 982 
 983 

 984 

To clear the list of the Recently Viewed Zones, press on the button “Clear all zones”: 985 

 986 

 987 
 988 



The figure in brackets next to the zone name shows the number of the aggregated entries and exits to 989 

and from the selected Balancing Zone. 990 

 991 

 992 
 993 

 994 

 995 

 996 

 997 

 998 

 999 

 1000 

 1001 

 1002 

 1003 

 1004 

 1005 

 1006 

 1007 

 1008 

 1009 

 1010 

 1011 

 1012 

 1013 



5.4. REDIRECTION OPTIONS 1014 

 1015 

 1016 
 1017 

How to access TP Data Part from the TP Map? 1018 

 1019 

There are many possibilities to access TP data from the Map. 1020 

 1021 

 Through POINT menu - > DATA submenu: 1022 

 1023 

 1024 
 1025 

 1026 

 Through ZONE menu - > DATA submenu: 1027 

 1028 

 1029 
 1030 

 1031 

 By searching for an object through the SEARCH BAR:  1032 

Select the item of interest from the drop-down menu that appears and click on the bar chart 1033 

symbol: 1034 

 1035 



 1036 
 1037 

 1038 

 Through the left sidebar – Recently Views Items: 1039 

Select and unfold an item of interest from the Recently Views Items. Click on a Bar chart symbol 1040 

to get direct access to the data for particular operator/direction: 1041 

 1042 

 1043 



 Through Map point pop-up: 1044 

Click on a selected point on the map. By clicking on a Bar chart symbol on the Point pop-up you 1045 

can access the data published by particular operator for the selected point direction: 1046 

 1047 

 1048 
 1049 

 1050 

 Through Map zone pop-up: 1051 

Click on a selected zone on the map. Through the Zone pop-up you can get access to data about 1052 

the points and adjacent zones connected to the selected Balancing Zone: 1053 

 1054 

 1055 
 1056 

 1057 

 1058 

 1059 

 1060 

 1061 

 1062 

 1063 



6. SEARCH BAR AND ADVANCED SEARCH FUNCTIONS 1064 

 1065 

6.1. SEARCH BAR 1066 

 1067 

 1068 
  1069 

  1070 

 1071 
 1072 

Through the Search bar the TP user can search for a point, balancing zone, operator, country or location 1073 

by using the EIC code, the name or part of the name of the object in interest. 1074 

The search results will return a drop-down menu listing the objects with match of the searched 1075 

information. 1076 

 1077 

 1078 



In the case of network point search, during the name input, a drop-down menu appears below the 1079 

Search bar showing information about the point, operator(s) and zone(s) to which the point belongs. 1080 

 1081 

 1082 
 1083 

 1084 

 1085 

 1086 

 1087 

 1088 

 1089 

 1090 

 1091 

 1092 

 1093 

 1094 

 1095 

 1096 

 1097 

 1098 

 1099 

 1100 

 1101 

 1102 

 1103 

 1104 

 1105 



 1106 
 1107 

In the case of an exact match between the searched and an existing on the platform network point 1108 

name, after clicking ENTER, the point is shown on the map. 1109 

 1110 

 1111 
 1112 

 1113 

 1114 

 1115 

 1116 

 1117 

 1118 

 1119 

 1120 

 1121 

 1122 

 1123 



 1124 
 1125 

When searching for a point through the Search bar, during the name input, a drop-down menu appears 1126 

below the bar. Detailed information on point, including values published by the relevant TSOs for the 1127 

required indicators, can be accessed directly from this drop-down menu. 1128 

 1129 

 1130 
 1131 

To access the point transport data:  1132 

 1133 

1. Press on the name of the connection point shown on the drop-down menu; 1134 

2. Choose the point direction and select the TSO whose information shall be displayed: 1135 

 1136 



 1137 
 1138 

 1139 

 1140 
 1141 

As you can see, there are different levels displayed under a point name in the shown drop-down menu: 1142 

 Level 1 – Arc level: 1143 

It shows which Balancing Zones or infrastructures are connected by the point.  1144 

Next to this line, a chart symbol is always displayed.  1145 

 1146 

 1147 
 1148 

 1149 



 Level 2 – Operators level: 1150 

It shows which operators are connected in this the respective Arc, and what is their relative flow 1151 

direction. A chart symbol is displayed if the operator mentioned publishes data in this direction.  1152 

 1153 

 1154 
 1155 

Clicking on the chart symbols will have a different effect depending on their position: 1156 

  1157 

> Clicking on the chart symbol at Level 1 redirects you to the “Points Data” page, clears up all 1158 

previously shown data, and displays all the operator flow directions linked to the Arc in Level 1. 1159 

 1160 

> Clicking on the chart symbol at Level 2 redirects you to the “Points Data” page, does not clear up 1161 

previously shown data, but instead adds to these data a new series with the operator flow direction 1162 

selected. 1163 

 1164 

 1165 

 1166 

 1167 

 1168 

 1169 

 1170 

 1171 

 1172 

 1173 

 1174 

 1175 

 1176 

 1177 

 1178 

 1179 

 1180 



 1181 
 1182 

 1183 
 1184 

In the example above, the point “Waidhaus” is shown. Two Arcs are displayed: 1185 

> Czech > NCG; 1186 

> NCG > Czech.  1187 

 1188 

This means that the point can be used to exchange gas either from Czech balancing zone to NCG 1189 

balancing zone, or from NCG balancing zone to Czech balancing zone.  1190 

 1191 

Under the Arc Czech > NCG, we can see three lines: 1192 

> N4G Exit; 1193 

> OGE Entry; 1194 

> GRTD Entry. 1195 

 1196 

This means that one operator (NET4GAS) delivers gas from the Czech balancing zone to two operators  1197 

(OPEN GRID EUROPE, GRTGAZ DEUTSCHLAND) in the NCG Balancing Zone.  1198 

 1199 

 1200 

 1201 

 1202 

 1203 

 1204 



Clicking on the chart symbol next to the “Czech > NCG”: 1205 

 1206 

 1207 
 1208 

will redirect you to the “Points Data” page, and load the data of all three operator lines.  1209 

On this way, you can easily compare the data provided in entry and exit direction, which generally 1210 

should match, unless there are specific circumstances like pipe-in-pipe agreements: 1211 

 1212 

 1213 
 1214 

Clicking on the chart symbol next to “N4G exit”: 1215 

 1216 

 1217 



will redirect you to the “Points Data” page, but will only load the exit data provided by NET4GAS: 1218 

 1219 

 1220 
 1221 

 1222 

 1223 
 1224 

We detected an issue related to the access to the Point Data from the Search bar, when accessing the 1225 

Platform from computers with MS Windows 8.1 Operating system. The problem is related to 1226 

localStorage API. 1227 

To workaround this issue, you have to: 1228 

1. Refresh the page - press F5 key or click on “Reload” button of the browser; 1229 

2. Clear the cache; 1230 

3. Clear the local storage. 1231 

 1232 

Below you can find further instructions on how to clear the cache and the local storage on the most 1233 

common web-browsers: 1234 

 1235 

Browser How to clear the cache? How to clear the localStorage? 

 

o Click on the Gear icon at the top 
right of the browser window and 
select Internet Options; 

o Click Delete under Browsing 
History; 

o Uncheck every box except the box 
for Temporary Internet Files in 
the Delete Browsing History 
window; 

o Click Delete; 
o Click OK. 

Open the navigator console using F12 

Key or via the menu  

Tools > Development tools; 

 

Execute the following commands on the 

console:  

localStorage.clear(); 

sessionStorage.clear(); 



 

o Click on Tools on the menu bar 
and select Clear Recent History; 

o Select everything from the Time 
range to clear drop-down list; 

o Click the down arrow next to 
Details; 

o Click to check the box Cache; 
o NOTE: Make sure to check Cache 

only; 
o Click Clear Now; 
o Click OK; 
o Close and reopen the browser. 

Open the navigator console using F12 

Key or via the menu  

Tools > Web Developer extension; 

 

Execute the following commands on the 

console:  

localStorage.clear(); 

sessionStorage.clear(); 

 

o Click the Chrome Tools icon on the 
menu; 

o Select Options; 
o Click the Under the Hood tab; 
o Click the Clear browsing data  

button; 
o Click to check the Empty the cache 

box; 
o Click the Clear browsing data 

button; 
o Click the Close button; 
o Close and reopen the browser. 

Open the navigator console using 
Ctrl+Shift+J combination or via the menu  
Tools > JavaScript Console 
 

Execute the following commands on the 

console:  

localStorage.clear(); 

sessionStorage.clear(); 

 

o Go to a non-LexisNexis webpage; 
o Click the Safari menu and select 

Reset Safari; 
o Click to check the box Empty the 

cache; 
o Click Reset; 
o Close and reopen the browser. 
 

To activate the console:  
o Click the Safari Tools icon on the 

menu; 
o Select Preferences; 
o Select the Advanced Tab; 
o Check checkbox "Show the 

developement pmenu in the Menu 
bar"; 

o Ctrl+Alt+I  or  Ctrl+Alt+C 
 

Execute the following commands on the 

console:  

localStorage.clear(); 

sessionStorage.clear(); 

 1236 

 1237 

 1238 

 1239 

 1240 

 1241 

 1242 

 1243 

 1244 



6.2. ADVANCED SEARCH FUNCTIONS 1245 

 1246 

 1247 

The ENTSOG TP provides to its users Advanced Search possibilities for points and zones.  1248 

 1249 

 1250 

 ADVANCED SEARCH FUNCTIONALITY FOR POINTS 1251 

 1252 

The tool for points advanced search is accessible through POINTS menu -> ADVANCED SEARCH 1253 

 1254 

 1255 
 1256 

The advanced searched options available are: 1257 

 Point name; 1258 

 From country; 1259 

 From zone; 1260 

 From infrastructure; 1261 

 From operator; 1262 

 From operator point; 1263 

 From identifier; 1264 

 To identifier; 1265 

 To operator point; 1266 

 To operator; 1267 

 To infrastructure; 1268 

 To zone; 1269 

 To country. 1270 

 1271 

 1272 

 1273 

 1274 

 1275 

 1276 

 1277 

 1278 



To find information based on a certain point you should enter data in the search fields: 1279 

 1280 

 1281 
 1282 

 1283 
 1284 

ENTSOG TP provides direct access to the data published for the point in quest through the Bar chart  1285 

symbol or Access data page button  1286 

By clicking on the Balloon sign from the Point name field the TP will show the point on the map.  1287 

If you are a Registered TP user logged in to your user profile, by clicking on the Star  symbol next to 1288 

the name of the point, you can add it in the list of your favourite objects.  1289 

 1290 

 1291 

 1292 

The columns FROM IDENTIFIER and TO IDENTIFIER also contain a Bar chart  symbol.  1293 

Clicking on the symbol in the FROM IDENTIFIER column will only display the data in the left part of the 1294 

Advanced Search, i.e. all the exits. Clicking on this symbol in the TO IDENTIFIER column will only display 1295 

the data in the right part of the Advanced Search, i.e. all the entries. 1296 

 1297 

 1298 

 1299 
 1300 

In the Advanced Search, filter on “From CC”: DE and “To CC”: FR. You can see that there are two rows - 1301 

two exits from Germany, entering into a single entry point with a single identifier in France. 1302 

 1303 

> Clicking on Access data  button, loads the data for both exit TSOs (Open Grid 1304 

Europe, GRTgaz Deutschland) and entry TSO (GRTgaz); 1305 



> Clicking on the FROM IDENTIFIER column, loads only the exit data from Open Grid Europe and 1306 

GRTgaz Deutschland; 1307 

> Clicking on the TO IDENTIFIER column, loads only the entry data of GRTgaz. 1308 

 1309 

 1310 

 ADVANCED SEARCH FUNCTIONALITY FOR ZONES 1311 

 1312 

The tool for zones advanced search is accessible through ZONES menu -> ADVANCED SEARCH 1313 

 1314 

 1315 
 1316 

The advanced searched options available for requesting a zone are: 1317 

 Balancing zone name; 1318 

 Country code; 1319 

 Operator name; 1320 

 Flow direction; 1321 

 Name of the adjacent system. 1322 

 1323 

To find information based on a certain zone you should enter data in the search fields: 1324 

 1325 

 1326 
 1327 

The ENTSOG TP provides direct access to the data published for the zone in quest through the Bar chart 1328 

 symbol or Access data page button  1329 

By clicking on the Balloon sign from the Zone name field the TP will show the zone on the map.  1330 

 1331 

 1332 

 1333 

 1334 

 1335 



7. DATA PART 1336 

 1337 

 1338 

 1339 

The Bar chart symbol  is the shortcut to the Transparency Platform Data part, providing information 1340 

on the values of the TP point and zone indicators in numerical or graphical mode. 1341 

 1342 

 1343 
 1344 

The Data part of ENTSOG Transparency Platform can be reached in several different ways. 1345 

 1346 

1. Through the SEARCH BAR by writing the name of the object in quest and clicking the Bar chart 1347 

symbol: 1348 

 1349 

 1350 
 1351 

 1352 

 1353 

 1354 

 1355 

 1356 



2. Through the MAP by selecting the object in quest and clicking on the Bar chart symbol in the 1357 

Point or Zone pop-up window: 1358 

 1359 

 1360 
 1361 

3. Through the left hand sidebar RECENTLY VIEWED ITEMS, by selecting the object of interest and 1362 

clicking the Bar chart symbol next to its name: 1363 

 1364 

 1365 
 1366 

 1367 

 1368 



4. Through POINT menu - > DATA submenu: 1369 

 1370 

 1371 
 1372 

5. Through ZONE menu - > DATA submenu: 1373 

 1374 

 1375 
 1376 

6. Through OPERATORS menu - > TSO NAME Tab - > Zones: 1377 

 1378 

 1379 
 1380 



The DATA PART of ENTSOG Transparency Platform consists of the three panels: 1381 

 1382 

 DATA PANEL 1383 

 TIME PANEL 1384 

 INDICATORS PANEL 1385 

 1386 

 1387 
 1388 

 1389 

7.1. DATA PANEL 1390 

 1391 

 1392 

 1393 



 1394 
 1395 

The type of the graph for visualisation in the Data panel can be changed through a menu accessible 1396 

through the Gear-wheel symbol  in the Indicator panel: 1397 

 1398 
 1399 

  1400 
  1401 

 Examples of different graph visualisations: 1402 

 1403 

Bar chart 1404 

 1405 

 1406 
 1407 



 1408 
 1409 

 1410 

Stacked Area chart 1411 

 1412 

 1413 
 1414 

 1415 
 1416 

 1417 

Stacked Line graph 1418 

 1419 

 1420 
 1421 

 1422 



 1423 
 1424 

 1425 

 1426 
 1427 

 1428 

How to show information for more than one point simultaneously? 1429 

 1430 

 1431 
 1432 

In case that you are exploring the data for one point and would like to add and display information for 1433 

additional point(s) the easiest way is to use the Search bar. 1434 

 1435 

1. Starting position - You are displaying the data for one point: 1436 

 1437 



 1438 
 1439 

 1440 

2. Next step – Type the name of the new point of interest in the Search bar.  1441 

During the typing process a drop-down menu with list of the objects whose names match to the 1442 

typed name appears below the Search bar. 1443 

 1444 

 1445 
 1446 

 1447 

 1448 



3. Select the searched point by clicking on its name.  1449 

This will unfold additional selection options for this point – point direction, operator publishing 1450 

the data. 1451 

 1452 

 1453 
 1454 

4. Select the point direction and the source of the information and click on the respective Bar chart1455 

 symbol. 1456 

 1457 

 1458 



The information for each point is displayed in different colour. 1459 

The names of the points and their colour codes are shown in a legend below the graph pane. 1460 

 1461 

 1462 
 1463 

 1464 

The same information is presented at the same time in a numerical way in the Transport data tab. 1465 

 1466 

 1467 
 1468 

 1469 

 1470 

 1471 

 1472 

 1473 



 1474 
 1475 

Another possibility to show information for more than one point simultaneously, is to use the Recently 1476 

Viewed Items sidebar. This option would work if the points of interest were explored by the user during 1477 

the current working session and respectively presented in the Recently Viewed Items list. 1478 

The Recently Viewed Items list contains the object recently searched or observed on the TP. 1479 

When the Recently Viewed Items list is populated with objects of interest, in order to display their data 1480 

just press the Bar chart symbol at Arc or Operator level, or click on Plus  sign next to the operator 1481 

name. To show data for other point(s)/direction(s), simply click on the respective Plus sign. 1482 

 1483 

 1484 



 1485 
 1486 

 1487 

The information for the different points is represented by a different colour on the Data pane: 1488 

 1489 

 1490 
 1491 

 1492 

 1493 

 1494 

 1495 

 1496 

 1497 

 1498 

 1499 



The data for the selected points is presented in the Transport data pane: 1500 

 1501 

 1502 
 1503 

 1504 
 1505 

Once you have displayed on the graph information for more than one point, by clicking on the name of 1506 

the points in series you can hide and show the information for the point(s). For details, see the example 1507 

below. 1508 

 1509 

 1510 
 1511 

Example for visualisation of Nomination information for 4 points simultaneously. The points of interest 1512 

are listed in the legend below the graph: 1513 



 1514 
 1515 

Examples of hiding the Nomination information for 2 of the points and displaying data for the remaining 1516 

2 points from the previous illustration.  1517 

The information for the points in grey are is hidden. Only the information for the points in black colour is 1518 

shown.  1519 

 1520 

 1521 

 1522 
 1523 

To show the data for the hidden points, click once on the names in the grey colour.  1524 

 1525 

 1526 

 1527 



 1528 
 1529 

In case that you cannot see any data on the chart of the data pane, this does not mean always that the 1530 

respective TSO does not publish information. It is possible that the data publication for the selected 1531 

indicators and point is not applicable.  1532 

 1533 

 1534 
 1535 

To verify whether an exemption has been configured by the TSO, please check the Transport data part. 1536 

 1537 

 1538 
 1539 

For more details on the Not Applicable functionality and the publication exemptions, please refer to 1540 

point 7.4.2.3. Data values publication exemptions. 1541 

 1542 

 1543 

 1544 

 1545 

 1546 

 1547 

 1548 

 1549 

 1550 



7.2. TIME PANEL 1551 

 1552 

 1553 

The time panel is for setting the validity period of the information in question, as well as for defining the 1554 

granularity of the data to be displayed and the time zone in which the time indicators are to be shown.  1555 

 1556 

 1557 
 DATA GRANULARITY CONFIGURATION 1558 

 1559 

The Time panel allows the TP user to choose between daily and hourly granularity of the displayed data. 1560 

The hourly data could be visualised if the respective TSO has an hourly balancing regime and publishes 1561 

data on an hourly basis. The TSOs with an hourly balancing regime are publishing information with both 1562 

hourly and daily granularity. 1563 

Switching between the hourly and daily publications is possible through the Daily data and Hourly data 1564 

buttons. The active mode is the blue one: 1565 

 1566 

 1567 
 1568 



 1569 
 1570 

Care should be taken when choosing hourly mode. You may want to first adjust the Date period selection 1571 

to a few days at most. By default, the TP displays data for a full month in daily mode - this means around 1572 

30 values per point and indicator, but in hourly mode it will be 24 times this amount, around 750 values, 1573 

it can look like you were displaying daily data over the previous two years.  1574 

The TP can handle these volumes, but it will cause a delay in displaying the data. 1575 

 1576 

 1577 

 TIME ZONE SETTINGS 1578 

 1579 

The Time zone of the displayed information can be changed through a drop-down menu: 1580 

 1581 
 1582 

 1583 

 DEFINING THE PERIOD IN QUESTION 1584 

 1585 

The period for which the information is displayed can be defined through the Time panel - From Gas day 1586 

– To Gas day calendar functions: 1587 

 1588 



 1589 
 1590 

 1591 

The selected period through the calendar is shown on the horizontal axis of the graph and on the slide 1592 

bar below the graph chart area. 1593 

 1594 

 1595 
 1596 

 1597 

 1598 



 1599 
 1600 

The TP user can narrow the period previously defined through the calendar and zoom in the displayed 1601 

graph by using the slide bar.  1602 

 1603 

 1604 
 1605 

If you press and hold the primary mouse button on the narrowed slot, you can slide it over the 1606 

predefined through the calendar period. 1607 

 1608 

 1609 
 1610 

 1611 
 1612 

 1613 

 1614 

 1615 

 1616 

 1617 

 1618 

 1619 

 1620 

 1621 

 1622 

 1623 

 1624 

 1625 

 1626 

 1627 

 1628 

 1629 



7.3. INDICATORS PANEL 1630 

 1631 

 1632 

 POINT INDICATORS 1633 

 1634 

The Indicators panel allows TP users to select the point parameters for which information will be 1635 

displayed. 1636 

 1637 

 1638 
 1639 

Through the Indicators panel the users can activate or deactivate the data visualisation for 30 indicators 1640 

set in 3 groups: 1641 

 1642 

7.3.1.1. OPERATIONAL/TRANSPORT INDICATORS 1643 

 1644 

 1645 
 1646 

 1647 

 1648 

 1649 

 1650 

 1651 

 1652 



 CAPACITY INDICATORS 1653 

 1654 

 1655 
 1656 

 1657 

 INTERRUPTION INDICATORS 1658 

 1659 

 1660 
 1661 

 1662 

 1663 



 1664 
 1665 

To display information about more indicators simultaneously, simply select them by clicking the white 1666 

box next to the parameter name. The box next to an indicator name become green when selected. 1667 

 1668 

 1669 
 1670 

 1671 
 1672 

It is possible to display data for all indicators at once by selecting/deselecting the 1673 

 box next to the title of the Indicators panel. 1674 

 1675 

To activate and display information for all TP indicators, press the box next to INDICATORS title of the 1676 

panel. 1677 



 1678 
 1679 

If you want to activate/deactivate the information for a particular indicator, just mark/unmark the box 1680 

next to the indicator name. 1681 

 1682 



 1683 
 1684 

The information about each indicator is displayed in a different colour on the graph chart.  1685 

The correspondence between the colour code and the indicator is shown below the Data panel where 1686 

the name(s) of the point(s), point direction(s) and indicator for which information is displayed are listed: 1687 

 1688 

 1689 
 1690 

 ZONE INDICATORS 1691 

 1692 

The indicators for which information could be displayed for the Balancing Zones defined on ENTSOG TP 1693 

are Physical flow, Allocation and Nomination/Renomination data. 1694 

 1695 

 1696 



7.4. POINTS DATA PANEL TABS 1697 

 1698 

 1699 

 POINTS TAB 1700 

 1701 

In the Points tab, information about the selected point(s) and indicator(s) is presented in graphical way: 1702 

 1703 

 1704 
 1705 

The list of the points, including point directions and operator, as well as the indicator for which the data 1706 

is displayed on the graph, are listed in a legend below the data panel: 1707 

 1708 

 1709 
 1710 

 1711 

 TRANSPORT DATA TAB 1712 

 1713 

In the Transport data tab, the information about the selected point(s) and indicator(s) is presented in a 1714 

numerical way: 1715 

 1716 



 1717 
 1718 

 1719 

 1720 
 1721 

 1722 
 1723 

The information presented on Transport data panel can be sorted based on one or several parameters 1724 

simultaneously: 1725 

 1726 

 1727 
 1728 

The sorting could be done based on: 1729 

 Point name; 1730 

 Operator name; 1731 

 Point EIC; 1732 

 Point direction; 1733 

 Concerned period; 1734 

 Indicator; 1735 

 Value; 1736 

 Update date. 1737 

 1738 

To sort the data based on one parameter, simply press on the name of the parameter on the Parameter 1739 

bar. 1740 

 1741 

 1742 



In this example, the data is sorted based on its validity period: 1743 

 1744 

 1745 
 1746 

 1747 

In this example, the data is sorted based on the point name: 1748 

 1749 

 1750 
 1751 

 1752 

To sort the data based on two or several parameters simultaneously, press and hold the SHIFT key of the 1753 

keyboard and select the parameters for sorting. 1754 

In the following example, the data is sorted based on point name, point direction and validity period of 1755 

the data: 1756 

 1757 

 1758 
 1759 

 1760 



In the next example, the data is sorted based on point name, operator name and indicator: 1761 

 1762 

 1763 
 1764 

 1765 
 1766 

The information presented on the Transport data panel can be filtered based on one or several 1767 

parameters, by using the fields dedicated for this purpose. 1768 

 1769 

 1770 
 1771 

 1772 

 1773 

 1774 

 1775 

 1776 

 1777 

 1778 

 1779 

 1780 

 1781 

 1782 

 1783 

 1784 



 1785 
 1786 

Unfiltered information: 1787 

 1788 

 1789 
 1790 

 1791 

Information filtered based on the direction parameter – data is displayed only for the entry point 1792 

direction: 1793 

 1794 

 1795 
 1796 

 1797 

 1798 

 1799 

 1800 

 1801 

 1802 

 1803 



7.4.2.1. STATUS OF THE PUBLISHED INFORMATION 1804 

 1805 

In the Transport data tab the status of the published information could be indicated.  1806 

The status definition is available only for the following indicators: 1807 

 1808 

 Physical flow; 1809 

 Allocation; 1810 

 GCV; 1811 

 WI. 1812 

 1813 

The status of the data for these parameters can be defined by the TSO that is publishing the information 1814 

as: 1815 

 Provisional – denoted by orange ball:  1816 

 1817 

 1818 
 1819 

 1820 

 Confirmed – denoted by green ball:  1821 

 1822 

 1823 
 1824 

 1825 

 1826 

 1827 



7.4.2.2. DATA VALUES 1828 

 1829 

The value and the units of an indicator for a particular point (direction) and user defined period are 1830 

displayed in the Value section of the Transport data tab: 1831 

 1832 

 1833 
 1834 

 1835 

7.4.2.3. DATA VALUES PUBLICATION EXCEPTIONS 1836 

 1837 

There are exceptional cases when an operator cannot provide value(s) of a certain indicator for a 1838 

particular point, point direction and time period. These cases could be for regulatory reasons. 1839 

 1840 

For example: 1841 

 An import only point is defined as bidirectional. In the contraflow exit direction the operator does 1842 

not offer capacity. In this case it cannot publish any information for the indicators for the contraflow 1843 

direction. 1844 

 A point is defined as bidirectional. The flow is going mainly in one of the point directions. For the 1845 

opposite point direction the operator offers backhaul capacity. For this point direction the operator 1846 

cannot publish information about physical flow. 1847 

 1848 

For such cases ENSTOG TP provides functionality for setting the “N/A” (Not applicable) notation on the 1849 

place of the numerical value. In addition the operators must add a remark providing information for the 1850 

reason of not-applicability of the data publication. 1851 

 1852 

For the cases when the operator does not possess information that shall be published, the TP offers 1853 

possibility for setting a “-“ (Minus sign). 1854 

Such an instance could be the situation when an operator did not receive re-nomination(s) from the 1855 

shippers. Since in this case, the publication of zero value could be misleading, because in normal 1856 

circumstances a shipper could submit a re-nomination equal to 0 kWh/d or 0 kWh/h, the operator can 1857 

publish “-“ (Minus sign). 1858 

 1859 

The purpose of the Minus sign and N/A functionality is: 1860 

 To allow the operators to fulfil their publication obligations in case of regulatory exceptions or 1861 

absence of data; 1862 

 To facilitate TP users to comprehend the information provided.  1863 

 1864 



 1865 
 1866 

Example for N/A publications: 1867 

 1868 

 1869 
 1870 

 1871 
 1872 

Example for Minus sign publications: 1873 

 1874 

 1875 
 1876 

 1877 

 1878 

 1879 

 1880 

 1881 

 1882 



 1883 
 1884 

With regards to the aforementioned, the Blank cell of a Transport data value field means – Data not 1885 

published by the operator.  1886 

 1887 

 1888 
 1889 

 1890 

 CMP DATA TAB 1891 

 1892 

The CMP data tab shows information about the Unsuccessful request for firm capacity and/or capacity 1893 

allocated as a result of CMP procedure(s) application. 1894 

This section is dedicated for data publication in line with the requirements of Regulation (EC) N715/2009, 1895 

Annex I, point 3, 3.3(1), (h), (i), (j), (k). 1896 

 1897 

 1898 
 1899 

 1900 

 1901 

 1902 

 1903 

 1904 

 1905 

 1906 

 1907 

 1908 

 1909 



7.4.3.1. CMP UNSUCCESSFUL REQUESTS 1910 

 1911 

CMP Unsuccessful Requests section shows the occurrence(s) (if any) of unsuccessful, legally valid 1912 

requests for firm capacity products with a duration of one month or longer, including the number and 1913 

volume of the unsuccessful requests, by specifying concerned point, period, the requested, allocated and 1914 

unsatisfied capacity. 1915 

 1916 

 1917 
In case of an absence of occurrences of unsuccessful requests for firm capacity products with a duration 1918 

of one month or longer, the operators publish remarks containing explanation of the case. The 1919 

explanation is provided through sentences harmonised among the operators. 1920 

 1921 

 1922 
 1923 

7.4.3.2. CMP AUCTION RESULTS 1924 

 1925 

The CMP Auction Results section shows where and when firm capacity products with a duration of one 1926 

month or longer have cleared at prices higher than the reserve price, by specifying concerned point, 1927 

period, auction cleared and reserved price. 1928 

 1929 

 1930 



In case of absence of occurrences of auctions when firm capacity products with a duration of one month 1931 

or longer have cleared at prices higher than the reserve price, the operators publish remarks containing 1932 

an explanation of the case. The explanation is provided through sentences harmonised among the 1933 

operators. 1934 

 1935 

 1936 
 1937 

7.4.3.3. CMP UNAVAILABLE FIRM CAPACITY 1938 

 1939 

The CMP Unavailable Firm Capacity section shows where and when no firm capacity product with a 1940 

duration of one month or longer has been offered in the regular allocation process, by specifying 1941 

concerned point, period, and allocation process. 1942 

 1943 

 1944 
 1945 

In case of an absence of occurrences when no firm capacity product with a duration of one month or 1946 

longer has been offered in the regular allocation process, the operators publish remark containing 1947 

explanation of the case. The explanation is provided through sentences harmonised among the 1948 

operators. 1949 

 1950 

 1951 
 1952 



7.4.3.4. CMP CAPACITIES MADE AVAILABLE 1953 

 1954 

The CMP Capacities Made Available section shows total capacity made available through the application 1955 

of the congestion-management procedures: Oversubscription and Buy-Back, Firm day-ahead use-it-or-1956 

lose-it, Surrender of contracted capacity, Long-term use-it-or-lose-it, by specifying concerned point, 1957 

period and allocated volume per applied congestion-management procedure. 1958 

 1959 
 1960 

In case of an absence of occurrences when capacity was made available through the application of the 1961 

congestion-management procedures, the operators publish remarks containing an explanation of the 1962 

case. The explanation is provided through sentences harmonised among the operators. 1963 

 1964 

 1965 
 1966 

 1967 

 1968 

 1969 

 1970 

 1971 

 1972 

 1973 



 TARIFF DATA TAB 1974 

 1975 

The Tariff data tab shows information about the applied tariff value, units and type valid for the selected 1976 

point and period. 1977 

 1978 
 1979 

 1980 

 POINT INFORMATION TAB 1981 

 1982 

The Point information tab shows information about the point name, point identifier, validity period, 1983 

offered type of contracts per point, maximum value of the GCV and conversion factor used by the 1984 

respective TSO for converting the information from volume to energy units. 1985 

 1986 

 1987 
 1988 

 1989 
 1990 

The information presented on CMP data, Tariff data and Point information panels can be sorted based 1991 

on one or several parameters simultaneously. To sort the data simply press on the name of the selected 1992 

parameter(s) on the Parameter bar. For details, please refer to the explanation on how to sort data on 1993 

Transport data panel. 1994 



The information presented on CMP data, Tariff data and Point information panels can be filtered based 1995 

on one or several parameters by using the fields dedicated for this purpose. 1996 

For details, please refer to the explanation on how to filter data on Transport data panel. 1997 

 1998 

 1999 

 EXPORT WIZARD TAB 2000 

 2001 

Through the Export wizard the TP users can export information in CSV and XML format. The users can 2002 

choose the data to be exported by selecting the TSO in interest, point direction, point type (only CAM-2003 

Relevant or All points), data type (Transport data, CMP information, Point information). 2004 

 2005 

 2006 
 2007 

 2008 

 2009 

 2010 

 2011 

 2012 

 2013 

 2014 

 2015 

 2016 



 2017 
 2018 

Example on how to use the options of the Export wizard: 2019 

 2020 

The TSO whose point information is needed can be selected from a drop-down menu: 2021 

 2022 

 2023 
 2024 

The Type of exported information can be selected through the Source drop-down menu. 2025 



The Transport data includes flow, capacity, interruptions and gas quality data. 2026 

The CMP data includes information about the unsuccessful requests for firm capacity, auction results and 2027 

allocated capacity during the selected period.  2028 

 2029 

 2030 
 2031 

 2032 

 2033 

 2034 

 2035 

 2036 

 2037 



The information could be exported in CSV, XML, XLSX format. 2038 

 2039 

 2040 
 2041 

 2042 

 2043 

 2044 

 2045 

 2046 

 2047 

 2048 



For the CSV export, the TP users could choose either a comma or semi-colon delimiter. 2049 

 2050 

 2051 
 2052 

 2053 

 2054 

 2055 

 2056 

 2057 

 2058 

 2059 



 2060 
 2061 

How to export information for the physical flow through all CAM-Relevant points in Europe for the 2062 

period 1 July – 1 August 2015? 2063 

 2064 

In order to export the information in interest from the TP it is important not only to select the point type, 2065 

operator, direction and data source, but also to define the period and indicators for which the data is 2066 

needed. 2067 

The required period and indicators shall be selected through the respective Time/Calendar and 2068 

Indicators panels. 2069 

 2070 

 2071 
 2072 

 2073 

 2074 

 2075 
 2076 

How to export information about the unsuccessful requests for capacity received by a TSO for its exit 2077 

points during the period 1 July – 1 August 2015? 2078 

 2079 

For exporting CMP information, it is required to select the appropriate data source, point type and 2080 

direction, TSO and time period of interest. An example is shown below: 2081 

 2082 



 2083 
 2084 

 2085 

 2086 
 2087 

How to open a CSV document in XLS/XLSX (MS Excel) file? 2088 

 2089 

Once you have exported the information of your interest in CSV file format you could easily open and 2090 

save it in XLS/XLSX (MS Excel) format. 2091 

There are many possibilities. Two of them are presented in the examples below. 2092 

 2093 

 2094 

 2095 
 2096 

Follow the next 3 steps: 2097 

1. Click with the right mouse button on the file in CSV format; 2098 

2. Press on Open with and 2099 

3. Select MS Excel. 2100 

 2101 



 2102 
 2103 

 2104 

 2105 
 2106 

Another possibility is to open and convert a CSV file that you exported form ENTSOG TP in XLS/XLSX (MS 2107 

Excel) format is to use the Open command of MS Excel.  2108 

 2109 

1. Open MS Excel;  2110 

2. On the Data tab, in the Get External Data group, click From Text. Then, in the Import Text File 2111 

dialog box, browse to the CSV file that you exported form ENTSOG TP and double-click on it. 2112 

3. Follow the Text Import Wizard steps: 2113 

 2114 

Step 1: Set the following settings:  2115 

Original data type: Delimited 2116 

File origin: Windows (ANSI) 2117 

 2118 

 2119 



 2120 
 2121 

 2122 

Step 2: Set the following settings: 2123 

Delimiters: Select Comma 2124 

Text qualifier: Leave the default option quotation mark (") 2125 

 2126 

 2127 
 2128 

 2129 



Step 3: Set the following settings: 2130 

Column Data Format: General 2131 

Select FINISH. 2132 

 2133 

 2134 
 2135 

 2136 

 2137 
 2138 

Opening a text file (*.CSV or *.TXT) in MS Excel does not change the format of the file — you can see this 2139 

in the Excel title bar, where the name of the file retains the text file name extension (for example, .txt or 2140 

.csv). 2141 

 2142 

To convert the opened CSV file in XLS/XLSX format, go to File menu, select Save as option: 2143 

 2144 

 2145 
 2146 

and Save the file as: 2147 



Excel Workbook (*.xlsx) or  2148 

Excel 97-2003 Workbook (*.xls): 2149 

 2150 

 2151 
 2152 

 2153 

 2154 
 2155 

You can apply some filtering options on the extracted data by the using the MS Excel option Sort & Filter. 2156 

Go to Home menu, select Sort & Filter and press on Filter option. 2157 

 2158 

 2159 
 2160 

Filtering controls (Arrow  sign) automatically are added to the table headers.  2161 

For quick filtering, do this: 2162 

 2163 

 2164 



1. Click the arrow  in the table header of the column you want to filter. 2165 

2. In the list of text or numbers on the drop-down many that appears, uncheck the (Select All) box 2166 

at the top of the list, and then check the boxes of the items you want to show in your table.  2167 

 2168 

 2169 
 2170 

 2171 

7.4.6.1. EXPORT WIZARD FIELDS EXPLANATION 2172 

 2173 

Below you can find description of the information manually exportable through TP Export Wizard. Each 2174 

table contains explanation of the meaning of the column titles of the export files. 2175 

The provided samples in the “Possible values/Example” column should not be treated as an instance of a 2176 

real export file. The samples shall be examined on field by field basis as illustration of the possible export 2177 

values. 2178 

 2179 

 2180 

 2181 

 2182 

 2183 

 2184 

 2185 

 2186 

 2187 

 2188 

 2189 

 2190 



TRANSPORT DATA EXPORT 
FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

id Technical identifier which is a 
unique fingerprint of the data item. 

1Physical Flowday2016-02-
182016-02-19DE-TSO-0010ITP-
00019entrykWh/d 

dataSet Datasets represent groups of 
similar data items.  
Possible values: 
1: Transport Data indicators 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 
The value of the field shows the 
type of exported data set. 

1 

indicator Name of the indicator Physical Flow 

periodType Period Type (Day or Hour) - 
represents the granularity of the 
data. 

Day 

periodFrom Start of the period for which the 
information is valid (start of the gas 
day or gas hour).  
The hour is shown in the time zone 
selected by the TP user. 

2016-02-18 06:00 

periodTo End of the period for which the 
information is valid (end of the gas 
day or gas hour). 
The hour is shown in the time zone 
selected by the TP user. 

2016-02-19 06:00 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

DE-TSO-0010 

tsoEicCode EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21X-DE-A-A0A0A-A 

operatorLabel TSO name Bayernets 

pointKey Unique ID of the point in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

ITP-00007 

pointLabel Name of the point for which 
information is exported. 

Überackern SUDAL (AT) / 
Überackern 2 (DE) 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z0000000001240 



directionKey Flow direction (Entry or Exit) Entry 

unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

kWh/d 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports. 

Remark text could appear here if 
published by the TSO. 

generalRemarks Generic optional remark over a 
group of data items published by 
the TSO at the same time. 

General remark information for 
the group of data (for example 
for all Nominations publications) 
could appear here if published by 
the TSO. 

value Value of the indicator 21742397 

lastUpdateDateTime The date of the upload of the 
information on the TP.  
For Capacity and Interruption 
indicators - the date at which the 
last change in value was observed. 

2016-02-19 10:10 

isUnlimited The field is valid only for 
Interruptible capacity.  
In case that the Interruptible 
capacity offered by a TSO is 
unlimited, the value of the field is 
set to TRUE and the TP visualize the 
symbol "∞".  
The value of the field is FALSE if the 
Interruptible capacity offered by 
the TSO is not unlimited. 
The field is empty if the 
information is exported for 
indicator different than 
Interruptible capacity. 

 

flowStatus The status of the information 
(Provisional or Confirmed), 
displayed only for Physical flow, 
Allocation, GCV and WI values. 

Confirmed 
 

interruptionType The type of interruption (Planned, 
Unplanned, Actual), valid only for 
Interruption data. 
The field is empty if the 
information is exported for 
parameters different than 
Interruption indicators. 

 



restorationInformation The field is valid only for the 
Interruption data.  
It may contain free text 
information provided by the TSO 
about the expected restoration 
from an interruption event. The 
information is not visualized on the 
Platform. 
If submitted by the TSO, it is 
available only for export.  

 

capacityType Type of capacity (Firm or 
Interruptible), valid only for 
Capacity and Interruption data. 
The field is empty if the 
information is exported for 
parameters different than Capacity 
or Interruption indicators. 

 

capacityBookingStatus Booking status of the capacity 
(Booked, Available, Total), valid 
only for Capacity or Interruption 
data. The field is empty if the 
information is exported for 
parameters different than Capacity 
or Interruption indicators. 

 

isCamRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

isNA The field shows whether “Not 
Applicable” functionality for data 
publication was activated by the 
TSO for the particular 
point/direction/indicator/period.  
If the value of the field is TRUE, this 
means that a “Not applicable” 
functionality is activated and 
instead of displaying a value on the 
platform “N/A” is published.  
If the field is blank, this means that 
there are no exceptions and the 
value of the indicator shall be 
presented.  

 

originalPeriodFrom Technical field represents the first 
day on which the “Not applicable” 
solution has been activated. The 
field is only filled, if “isNA” is set to 
TRUE. 

 

 2191 

 2192 



POINTS INFORMATION  
EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

pointKey Unique ID of the point in the TP 
Database. 
Contrary to the EIC codes, this ID 
can never change. 

ITP-00056 

pointLabel Name of the point Oberkappel (GRTgaz D) 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

DE-TSO-0004 

operatorLabel TSO name GRTgaz Deutschland 

directionKey Flow direction (Entry or Exit) entry 

validFrom Point validity start date, as defined 
by ENTSOG TP administrator. 
 
The indicator is not relevant for 
this dataset. 

Example not applicable. 

validTo Point validity end date, as defined 
by ENTSOG TP administrator. 
 
The indicator is not relevant for 
this dataset. 

Example not applicable. 

hasData TRUE in case that the TSO has 
configured its IT system to publish 
data at this point. 
Please note that it just means that 
the TSO has the technical ability to 
provide data at the point. It may 
happen that data may still be 
missing temporarily for certain 
days, in case of punctual data 
communication errors. 
When FALSE or empty, it means 
that the TSO has not configured its 
IT system to upload data for this 
point, i.e. the point is not relevant. 

TRUE 

isVirtualizedCommercially TRUE in case that the point is 
commercially virtualized. In this 
case, the data is published for the 
virtual point.  
FALSE if the point is not virtualized 
commercially. 

FALSE 

virtualizedCommerciallySince The start date of the commercial 
virtualization of the point after 
which the information is published 
for the virtual point. 
The field is empty if the value of 

 



the “isVirtualizedCommercially” is 
FALSE. 

isVirtualizedOperationally TRUE in case that the point is 
operationally virtualized. In this 
case the data is published for the 
virtual point.  
FALSE if the point is not virtualized 
operationally. 

FALSE 

virtualizedOperationallySince The start date of the operational 
virtualization of the point after 
which the information is published 
for the virtual point. 
The field is empty if the value of 
the “isVirtualizedOperationally” is 
FALSE. 

 

isPipeInPipe TRUE if a pipe-in-pipe situation is 
valid for the point, otherwise the 
value of the field is FALSE. 

TRUE 

pipeInPipeWithTsoKey The TP ID of the other TSO 
participating in the pipe-in-pipe 
situation and the TP ID of the point. 
The filed is depended of the value 
of the fields “isPipeInPipe”. 
If the value of the fields 
“isPipeInPipe” is TRUE, the field 
“pipeInPipeWithTsoKey” contain 
the TP ID of the respective TSO and 
the TP ID of the point.  

DE-TSO-0009/ITP-00006 

pipeInPipeWithTsoLabel The name of the other TSO 
participating in the pipe-in-pipe 
situation and the name of the 
point. 
The filed content is depended of 
the value of the fields 
“isPipeInPipe”. 
If the value of the fields 
“isPipeInPipe” is TRUE, the field 
“pipeInPipeWithTsoLabel” contain 
the name of the respective TSO and 
the name of the point. 

Open Grid Europe/Oberkappel 
(OGE) 

isDoubleReporting TRUE if the TSO is publishing the 
data at the point on behalf of 
another TSO, for legal reasons. 

FALSE 

doubleReportingWithTsoKey The TP ID of the TSO to which the 
point actually belongs and the TP 

 



ID of the point. 
The filed content is depended of 
the value of the fields 
“isDoubleReporting”. 
If the value of the fields 
“isDoubleReporting” is TRUE, the 
field “doubleReportingWithTsoKey” 
contain the TP ID of the respective 
TSO to which the point belongs and 
the TP ID of the point. 

doubleReportingWithTsoLabe
l 

The name of the TSO to which the 
point actually belongs and the 
name of the point. 
The filed content is depended of 
the value of the fields 
“isDoubleReporting”. 
The filed is depended of the value 
of the fields “isDoubleReporting”. 
If the value of the fields 
“isDoubleReporting” is TRUE, the 
field 
“doubleReportingWithTsoLabel” 
contain the name of the respective 
TSO to which the point belongs and 
the name of the point. 

 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z000000000161V 

tpTsoItemLabel The name of the point, as defined 
by the TSO 

Oberkappel 

tpTsoValidFrom Point validity start date, as defined 
by the TSO. 

2005-10-01 00:00 

tpTsoValidTo Point validity end date, as defined 
by the TSO. 

2099-12-3 00:00 

tpTsoRemarks Optional remark about the point 
defined by the TSO. 

Remark text could appear here if 
published by the TSO. 

tpTsoConversionFactor Conversion factor to be used for 
conversion of the capacity value 
from volume to energy units, in 
case that the data is submitted by 
the TSO in volume. The value is 
equal to "1" in case that the 
capacity value is submitted by the 
TSO directly in energy units and no 
conversion is needed. 

1 



tpRmkGridConversionFactorC
apacityDefault 

Optional remarks provided by the 
TSO that can eventually provide 
more information about the 
conversion factor used. 

Remark text could appear here if 
published by the TSO. 

tpTsoGCVMin Default value of the GCV defined by 
the TSO for conversion purposes. 

11.1 

tpTsoGCVMax Maximum value of the GCV defined 
by the TSO for conversion purposes 
(optional). 

 

tpTsoGCVRemarks Optional remark about the value of 
the GCV published by the TSO for 
conversion purposes.  

Remark text could appear here if 
published by the TSO. 

tpTsoGCVUnit Unit for the GCV data kWh/m³ 

tpTsoEntryExitType Type of the point according to the 
TSO (Entry, Exit, or Entry-Exit) 
 
The indicator is not relevant for 
this dataset. 

Example not applicable. 

multiAnnualContractsIsAvaila
ble 

TRUE in case that the TSO offers 
Multi-annual contracts at the 
particular point.  
FASLE if Multi-annual contracts are 
not offered. 

FALSE 

multiAnnualContractsRemark
s 

Optional remark about the Multi-
annual contracts published by the 
TSO. 

Remark text could appear here if 
published by the TSO, for 
example: “Contracts shall start at 
the 1st day of the month”. 

annualContractsIsAvailable TRUE in case that the TSO offers 
Annual contracts at the particular 
point.  
FASLE if Annual contracts are not 
offered. 

TRUE 

annualContractsRemarks Optional remark about the Annual 
contracts published by the TSO. 

Remark text could appear here if 
published by the TSO, for 
example: “Contracts shall start at 
the 1st day of the month”. 

halfAnnualContractsIsAvailabl
e 

TRUE in case that the TSO offers 
Half-annual contracts at the 
particular point.  
FASLE if Half-annual contracts are 
not offered. 

FALSE 

halfAnnualContractsRemarks Optional remark about the Half-
annual contracts published by the 
TSO. 

Remark text could appear here if 
published by the TSO, for 
example: “Contracts shall start at 
the 1st day of the month”. 



quarterlyContractsIsAvailable TRUE in case that the TSO offers 
Quarterly contracts at the 
particular point.  
FASLE if Quarterly contracts are not 
offered. 

TRUE 

quarterlyContractsRemarks Optional remark about the 
Quarterly contracts published by 
the TSO. 

Remark text could appear here if 
published by the TSO. 

monthlyContractsIsAvailable TRUE in case that the TSO offers 
Monthly contracts at the particular 
point.  
FASLE if Monthly contracts are not 
offered. 

TRUE 

monthlyContractsRemarks Optional remark about the Monthly 
contracts published by the TSO. 

Remark text could appear here if 
published by the TSO, for 
example: “Contracts shall start at 
the 1st day of the month”. 

dailyContractsIsAvailable TRUE in case that the TSO offers 
Daily contracts at the particular 
point. FASLE if Daily contracts are 
not offered. 

FALSE 

dailyContractsRemarks Optional remark about the Daily 
contracts published by the TSO. 

Remark text could appear here if 
published by the TSO. 

dayAheadContractsIsAvailabl
e 

TRUE in case that the TSO offers 
Day-ahead contracts at the 
particular point.  
FASLE if Day-ahead contracts are 
not offered. 

TRUE 

dayAheadContractsRemarks Optional remark about the Day-
ahead contracts published by the 
TSO. 

Remark text could appear here if 
published by the TSO. 

availableContractsRemarks Optional remark about the 
available contracts offered by the 
TSO at the particular point. 

Remark text could appear here if 
published by the TSO. 

sentenceCMPUnsuccessful In case of an absence of 
unsuccessful requests for firm 
capacity products with duration of 
one month or longer, the TSOs 
publish remark containing 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs. 

Currently there are no requests 
for firm capacity products on this 
point with a duration of one 
month or longer that weren't 
successfully fulfilled. 



sentenceCMPUnavailable In case of an absence of 
occurrences when no firm capacity 
product with a duration of one 
month or longer has been offered 
in the regular allocation process, 
the TSOs publish remark containing 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs. 

Currently firm products with a 
duration of one month or longer 
are offered on this point in the 
regular allocation process. 

sentenceCMPAuction In case of absence of occurrences 
of auctions when firm capacity 
products with a duration of one 
month or longer have cleared at 
prices higher than the reserve 
price, the TSOs publish remark 
containing an explanation of the 
case. The explanation is provided 
through sentences harmonized 
among the TSOs. 

Currently there are no firm 
capacity products on this point 
with a duration of one month or 
longer auctioned having cleared 
with an auction premium. 

sentenceCMPMadeAvailable In case of an absence of 
occurrences when capacity was 
made available through the 
application of the congestion-
management procedures, the TSOs 
publish remark containing an 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs. 

Currently no capacity has been 
made available on this point 
through the application of the 
congestion-management 
procedures. 

lastUpdateDateTime The date at which the information 
was last updated by the TP. 

2016-04-18 11:04 

isInvalid Technical element used to denote 
an objects/information which is not 
valid anymore (e.g. point which has 
been terminated). TRUE is the 
object is not valid. FALSE if the 
object is valid. 

FALSE 

isCAMRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

id Technical identifier which is a 
unique fingerprint of the data item. 

5DE-TSO-0004ITP-00056entry 



dataSet Datasets represent groups of 
similar data items. Possible values: 
1: Operators 
2: Points 
3: Balancing Zones 
4: Interconnections 
5: Operator Point Directions 
6: Aggregate Interconnections 
The value of the field shows the 
type of exported data set. 

5 
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 2200 

 2201 

 2202 

 2203 

 2204 

 2205 

 2206 

 2207 

 2208 

 2209 

 2210 

 2211 

 2212 

 2213 

 2214 

 2215 

 2216 

 2217 

 2218 

 2219 

 2220 
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ZONES INFORMATION 
EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

id Technical identifier which is a 
unique fingerprint of the data item. 

1AggregatesDEDE-GASPOOL-DE-
TSO-0005entryProduction2016-
02-18T00:00:00+00:002016-02-
19T00:00:00+00:00Physical Flow 

dataSet Datasets represent groups of 
similar data items.  
Possible value for the Zones 
information export: 
1: Aggregated Data at Balancing 
Level. 

1 

dataSetLabel Datasets represent groups of 
similar data items.  
Aggregates: Aggregated Data at 
Balancing Level. 
The value of the field shows the 
type of exported data set. 

Aggregates 

indicator Name of the indicator. 
Possible values: 
- Physical flow; 
- Nomination/Re-nomination; 
- Allocation. 

Physical Flow 

periodType Period Type (Day or Hour) - 
presents the granularity of the 
data. 

Day 

periodFrom Start of the period for which the 
information is valid (start of the gas 
day or gas hour).  
The hour is shown in the time zone 
selected by the TP user. 

2016-02-18 06:00 

periodTo End of the period for which the 
information is valid (end of the gas 
day or gas hour). 
The hour is shown in the time zone 
selected by the TP user. 

2016-02-19 06:00 

countryKey Country code of the name of the 
country to which the balancing 
zone belongs. 

DE 

countryLabel Name of the country to which the 
balancing zone belongs. 

Germany 

bzKey Unique ID of the balancing zone in 
the TP Database. 

DE-GASPOOL- 

bzShort Abbreviation/short name of the 
balancing zone. 

GASPOOL 

bzLong Full name of the balancing zone GASPOOL Balancing Zone 



operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

DE-TSO-0005 

operatorLabel TSO name Gasunie Deutschland Transport 
Services GmbH 

tsoEicCode EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21X-DE-D-A0A0A-K 

directionKey Flow direction (Entry or Exit) Entry 

adjacentSystemsKey Unique ID of the adjacent system 
to the balancing zone. 

Production 

adjacentSystemsLabel Adjacent system name Production 

year Year of the date for which the 
information is exported. 

2016 

month Name of the month for which the 
information is exported: 
1: January 
2: February 
…. 
11: November 
12: December 

2 

day Date of the month for which the 
information is exported. 

18 

unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

kWh/d 

value Value of the exported indicator 81666593 

countPointPresents Total number of points for which 
the indicator values is aggregated. 

2 

flowStatus The status of the information 
(Provisional or Confirmed) 

Provisional 

pointsNames List of the points which were 
aggregated to produce the data 
item, separated by “|” as delimiter. 

Production (DE) (GUD) H-Gas-
Summe Produktion|Production 
(DE) (GUD) L-Gas-Summe 
Produktion 

lastUpdateDateTime The date of the publication of the 
information. 

2016-02-23 12:46 
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CMP UNSUCCESSFUL 
REQUEST EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

periodFrom Start of the period for which the 
information is valid. 
The hour is shown in the time zone 
selected by the TP user. 

2015-01-01 00:00 

periodTo End of the period for which the 
information is valid. 
The hour is shown in the time zone 
selected by the TP user. 

2015-03-31 00:00 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

FR-TSO-0003 

tsoEicCode EIC code of the TSO.  
The EIC code of the TSO may 
change over time. 

21X-FR-A-A0A0A-S 

operatorLabel TSO name GRTGaz 

pointKey Unique ID of the point in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

ITP-00163 

pointLabel Name of the point Liaison Nord Sud 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z000000000166L 

directionKey Flow direction (Entry or Exit) Exit 

unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

kWh/d 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports.  

Remark text could appear here if 
published by the TSO 

generalRemarks In case of an absence of 
occurrences of unsuccessful 
requests for firm capacity products 
with duration of one month or 
longer, the TSOs publish remark 
containing explanation of the case. 
The explanation is provided 
through sentences harmonized 
among the TSOs,  
 
i.e: “Currently there are no 
requests for firm capacity products 
on this point with duration of one 

 



month or longer that weren't 
successfully fulfilled.” 
 
The field is empty, in case of 
occurrences of unsuccessful 
requests for firm capacity products 
with duration of one month or 
longer and then information in the 
fields “requestedVolume”, 
“allocatedVolume”, 
“unallocatedVolume” and 
“occurenceCount” is published. 

requestedVolume Requested capacity 26094888 

allocatedVolume Allocated capacity 1513200 

unallocatedVolume Unallocated capacity 24581688 

lastUpdateDateTime The date of the publication of the 
information. 

2016-01-27 18:12 

occurenceCount Number of occurrences of 
unsuccessful requests for firm 
capacity during the pointed period. 

31 

indicator The indicator is not relevant for 
this dataset. 

Example not applicable. 

periodType The indicator is not relevant for 
this dataset. 

Example not applicable. 

isUnlimited The indicator is not relevant for 
this dataset. 

Example not applicable. 

flowStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

interruptionType The indicator is not relevant for 
this dataset. 

Example not applicable. 

restorationInformation The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityType The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityBookingStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

value The indicator is not relevant for 
this dataset. 

Example not applicable. 

id Technical identifier which is a 
unique fingerprint of the data item. 

22014-12-31 23:00:00 
+00:002015-03-30 22:00:00 
+00:00FR-TSO-0003ITP-
00163ExitkWh/d 



dataSet Datasets represent groups of 
similar data items. Possible values: 
1: Transport Data indicators. 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 
The value of the field shows the 
type of exported data set. 

2 

isCamRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

isNA The indicator is not relevant for 
this dataset. 

Example not applicable. 

originalPeriodFrom The indicator is not relevant for 
this dataset. 

Example not applicable. 
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CMP AUCTION RESULTS  
EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

auctionFrom Start of the auction slot 2016-01-18 09:00 

auctionTo End of the auction slot 2016-02-10 14:00 

capacityFrom Start of the period for which the 
capacity was auctioned. 

2016-03-01 06:00 

capacityTo End of the period for which the 
capacity was auctioned. 

2016-04-01 06:00 

operatorKey Unique ID of the TSO in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

DE-TSO-0004 

tsoEicCode EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21X000000001008P 

operatorLabel TSO name GRTgaz Deutschland 

pointKey Unique ID of the point in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

ITP-00056 

pointLabel Name of the point Oberkappel (GRTgaz D) 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z000000000161V 

directionKey Flow direction (Entry or Exit) Exit 

unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

EUR/kWh/h 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports.  

Remark text could appear here if 
published by the TSO 

generalRemarks In case of absence of occurrences 
of auctions when firm capacity 
products with a duration of one 
month or longer have cleared at 
prices higher than the reserve 
price, the TSOs publish remark 
containing an explanation of the 
case. The explanation is provided 
through sentences harmonized 
among the TSOs, 
 
i.e: “Currently there are no firm 
capacity products on this point with 
a duration of one month or longer 
auctioned having cleared with an 
auction premium”.  

 



 
The field is empty, in case of 
occurrences of auctions when firm 
capacity products with a duration 
of one month or longer have 
cleared at prices higher than the 
reserve price and then information 
in the fields “auctionPremium”, 
“clearedPrice”, “reserveprice” is 
published. 

auctionPremium Auction premium 0.080151 

clearedPrice Cleared price 0.396948 

reservePrice Reserve price 0.316797 

lastUpdateDateTime The date of the publication of the 
information. 

2016-03-01 10:38 

id Technical identifier which is a 
unique fingerprint of the data item. 

32016-01-18 08:00:00 
+00:002016-02-10 13:00:24 
+00:002016-03-01 05:00:00 
+00:002016-04-01 04:00:00 
+00:00DE-TSO-0004ITP-
00056exitEUR 

dataSet Datasets represent groups of 
similar data items. Possible values 
for the CMP related exports: 
1: Transport Data indicators. 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 
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CMP CAPACITY MADE 
AVAILABLE EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

id Technical identifier which is a 
unique fingerprint of the data item. 

1Available through UIOLI short-
termkWh/ddayDE-TSO-0010ITP-
00007entrykWh/d2016-02-
182016-02-19 

dataSet Datasets represent groups of 
similar data items. Possible values: 
1: Transport Data indicators. 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 
The value of the field shows the 
type of exported data set. 

1 

indicator The CMP procedure that has been 
applied for providing capacity in 
case of contractual congestion. 
Possible values: 
- Available through UIOLI short-

term; 
- Available through 

Oversubscription; 
- Available through Surrender; 
- Available through UIOLI long-

term. 

Available through UIOLI short-
term 

periodType Period Type (Day or Hour) - 
presents the granularity of the 
data. 

Day 

periodFrom Start of the period for which the 
information is valid. 

2016-02-18 06:00 

periodTo End of the period for which the 
information is valid. 

2016-02-19 06:00 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

DE-TSO-0010 

tsoEicCode EIC code of the TSO.  
The EIC code of the TSO may 
change over time. 

21X-DE-A-A0A0A-A 

operatorLabel TSO name Bayernets 

pointKey Unique ID of the point in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

ITP-00007 

pointLabel Name of the point Überackern SUDAL (AT) / 
Überackern 2 (DE) 



tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z0000000001240 

directionKey Flow direction (Entry or Exit) entry 

unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

kWh/d 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports. 

Remark text could appear here if 
published by the TSO 

generalRemarks In case of an absence of 
occurrences when capacity was 
made available through the 
application of the congestion-
management procedures, the TSOs 
publish remark containing an 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs,  
 
i.e: “Currently there are no request 
for firm capacity products on this 
point with a duration of one month 
or longer that weren't successfully 
fulfilled”.  
 
The field is empty, in case of 
occurrences when capacity was 
made available through the 
application of the congestion-
management procedures, and then 
the field “value” contains 
information about the capacity 
made available through the 
application of the procedure 
pointed in the “indicator” field. 

 

value Value of the capacity made 
available through the application of 
the pointed CMP procedure for the 
particular period and point. 

16134528 

lastUpdateDateTime The date of the publication of the 
information. 

2016-02-19 10:52 

isUnlimited The indicator is not relevant for 
this dataset. 

Example not applicable. 



flowStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

interruptionType The indicator is not relevant for 
this dataset. 

Example not applicable. 

restorationInformation The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityType The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityBookingStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

isCamRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

isNA The indicator is not relevant for 
this dataset. 

Example not applicable. 

originalPeriodFrom The indicator is not relevant for 
this dataset. 

Example not applicable. 

isDefaultSentence TRUE if the data item does not 
represent actual data, but the 
default sentence chosen by the TSO 
to indicate the reason.  

FALSE 

defaultSentence The default sentence chosen by the 
TSO to indicate why no actual data 
can be provided. The field content 
is depends of the value of the field 
“isDefaultSentence”. The field 
“defaultSentence “ is populated 
when the field  “isDefaultSentence” 
value is equal to TRUE.  
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CMP UNAVAILABLE FIRM 
EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

periodFrom Start of the period for which the 
information is valid (start of the gas 
day or gas hour).  
The hour is shown in the time zone 
selected by the TP user. 

2015-10-01 06:00 

periodTo End of the period for which the 
information is valid (end of the gas 
day or gas hour). 
The hour is shown in the time zone 
selected by the TP user. 

2016-10-01 06:00 

operatorKey Unique ID of the TSO in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

DE-TSO-0010 

tsoEicCode EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21X-DE-A-A0A0A-A 

operatorLabel Abbreviation of the TSO name Bayernets 

pointKey Unique ID of the point in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

ITP-00007 

pointLabel Name of the point Überackern SUDAL (AT) / 
Überackern 2 (DE) 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z0000000001240 

directionKey Flow direction (Entry or Exit) entry 

allocationProcess The regular allocation process 
applied at the point for the 
particular period.  
Possible values: 
- Auction; 
- FCFS; 
- OpenSubscription. 

Auction 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports.  

Remark text could appear here if 
published by the TSO 



generalRemarks In case of an absence of 
occurrences when no firm capacity 
product with a duration of one 
month or longer has been offered 
in the regular allocation process, 
the TSOs publish remark containing 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs,  
 
i.e: “Currently firm products with a 
duration of one month or longer 
are offered on this point in the 
regular allocation process”.  
 
The field is empty in case of 
occurrences when no firm capacity 
product with a duration of one 
month or longer has been offered 
in the regular allocation process 
pointed in the field 
“allocationProcess”. 

 

lastUpdateDateTime The date of the publication of the 
information. 

2016-01-27 18:12 

id Technical identifier which is a 
unique fingerprint of the data item. 

42015-10-01 04:00:00 
+00:002016-10-01 04:00:00 
+00:0021X-DE-A-A0A0A-ADE-
TSO-0010ITP-00007entryAuction 

dataSet Datasets represent groups of 
similar data items.  
Possible values: 
1: Transport Data indicators. 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 
The value of the field shows the 
type of exported data set. 

4 

indicator The indicator is not relevant for 
this dataset. 

Example not applicable. 

periodType The indicator is not relevant for 
this dataset. 

Example not applicable. 

unit The indicator is not relevant for 
this dataset. 

Example not applicable. 

value The indicator is not relevant for 
this dataset. 

Example not applicable. 

isUnlimited The indicator is not relevant for Example not applicable. 



this dataset. 

flowStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

interruptionType The indicator is not relevant for 
this dataset. 

Example not applicable. 

restorationInformation The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityType The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityBookingStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

isCamRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

isNA The indicator is not relevant for 
this dataset. 

Example not applicable. 

originalPeriodFrom The indicator is not relevant for 
this dataset. 

Example not applicable. 
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7.5. ZONES DATA PANEL TABS 2327 

 2328 

 ZONE DATA INDICATORS 2329 

 2330 

THE INDICATORS FOR WHICH DATA COULD BE DISPLAYED FOR A ZONE ARE: 2331 

 Physical flow – aggregated physical flow in entry or exit direction (to or from) the zone; 2332 

 Allocations – aggregated allocated quantities in entry or exit direction of the zone; 2333 

 Nominations – aggregated nominated capacity at all entry or at all exit points to or from the zone. 2334 

 2335 

 2336 
 2337 

 2338 

 ZONES TAB 2339 

 2340 

In the Zones tab information about the selected zone(s) and indicator(s) (physical flow, allocation data, 2341 

nomination information) is presented in graphical way: 2342 

 2343 

 2344 
 2345 

 2346 

The list of the selected zones, including the names of the operators and adjacent zones, as well as the 2347 

indicator for which the data is displayed on the graph, are listed below the data panel: 2348 

 2349 



 2350 
 2351 

 2352 

 TRANSPORT DATA TAB 2353 

 2354 

In the Transport data tab the information about the selected zones(s) and indicator(s) in numerical way 2355 

is presented: 2356 
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 2363 



 2364 
 2365 

The information presented on the Transport data panel can be sorted based on one or several 2366 

parameters simultaneously: 2367 

 2368 

 2369 
 2370 

The sorting could be done based on: 2371 

 Country name; 2372 

 Balancing zone name; 2373 

 Operator name; 2374 

 Direction; 2375 

 Adjacent system name; 2376 

 Validity period; 2377 

 Indicator; 2378 

 Value; 2379 

 Number of Aggregated points; 2380 

 Update date. 2381 

 2382 

To sort the data based on one parameter, simply press on the name of the parameter on the Parameter 2383 

bar. 2384 

The sorting functionalities at Zone Transport data tab are similar to the sorting possibilities of Points 2385 

Transport data Tab. For more details, please go to point 7.4.2.  2386 

 2387 

 2388 

 EXPORT WIZARD TAB 2389 

 2390 

Through the Export wizard the TP users can export information in CSV, XLSX and XML format. The users 2391 

can choose to export information either for all zones defined on the TP or by selecting a TSO for whose 2392 

balancing zone(s) the data to be exported. For description of the zone’s information exportable through 2393 

TP Export Wizard, please refer to point 7.4.6.1. 2394 
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 2397 

7.6. REDIRECTION OPTIONS 2398 

 2399 

How to access the TP Map from TP Data part without losing the currently displayed information? 2400 

 2401 

If you are currently exploring information at TP Data part for one or more points but you need to check 2402 

something on the TP Map and return again to the Data graph, Transport data or whatsoever of the 2403 

displayed Data Tabs follow the next steps: 2404 

 Move the mouse cursor on the Point menu without clicking on it. When the drop-down menu 2405 

appears, click on the Map: 2406 

 2407 

 2408 



 To Return from the TP Map to the previously displayed data – move again the mouse cursor on 2409 

the Point menu and on the drop-down menu, click on the Data: 2410 
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8. FEEDBACK 2442 

 2443 

 2444 

Dear ENTSOG TP User,  2445 

 2446 

We would like to thank you for your interest to our Transparency Platform.   2447 

 2448 

You have now reached the end of this manual. We hope you have found it useful. 2449 

We would appreciate your feedback and suggestions on how to improve its content and to facilitate your 2450 

experience with the ENTSOG Transparency Platform. 2451 

 2452 

Should you require more examples or details on any specific parts of the manual, please do not hesitate 2453 

to contact us by using the following email: 2454 

 2455 

transparency@entsog.eu 2456 

 2457 

Kind regards,  2458 

 2459 

ENTSOG TP Development team 2460 


